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CHAPTER

Overview

WAE Live gives immediate and easy access to both current and historical data. Combined, the Explore,
Analytics, and Map components offer flexible, interactive means of finding summarized aggregate views
or quickly narrowing the search to only relevant details. Explore enables you to interactively navigate to
current and historical data, and Analytics allows you to generate reports on this data. Map includes a
near-realtime weathermap and health panels from which you can navigate to relevant network data. Note
that WAE Live information is available on a per-network basis if configured by the administrator.

This guide includes the following chapters.

¢ Objects, Properties, and Data—Lists the objects and properties that can be shipped with WAE Live,
and describes the raw data that WAE Live uses.

e Common user interface tools

Graphs—Describes common elements of using the graphs in Explore and in the report output.

Tables and Filters—Describes common elements of using tables, including filtering options.

¢ Explore—Describes how to use Explore tables and graphs to navigate to data.

e Inventory—Describes different ways to view hardware inventory.

e Creating new reports

Configuring Reports—Describes the required steps for all report creation and how aggregation
works within reports. It also describes how to name reports, apply filters and sorting to named
reports, and export report data.

Traffic Reports—Describes how to create reports to determine current and projected traffic
trends, as well as project traffic.

Health Reports—Describes how to create reports to determine the health of network objects and
whether LAGs are imbalanced.

Deviation Reports—Describes how to create reports that identify sudden shifts in property
values.

Ad Hoc Reports—Describes how to create customized reports.

e Viewing, re-running, and scheduling reports

Reports—Describes how to view and rerun previous reports, as well as how to schedule and
email them.

Report Log—Describes how to view and rerun reports.

e Map—Describes how to use the Map panels and weathermap to determine current network health,
as well as how to navigate to more detailed network information.
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M Sample Use Cases

Sample Use Cases

Following are a few of the WAE Live use cases across diverse groups.

e Operators—Instantly detect backbone congestion, assess currently impacted LSPs, and decide
reroutes based on size and path.

e Planners—Develop trending reports for importing into WAE Design growth plan tools to determine
future needs, such as site-to-site traffic trends per class of service.

e Designers and Engineers—Determine whether LSPs are routed on their shortest paths over time and
what events cause them to reroute.

e Peering Coordinators—Monitor priority peers and their growth while verifying that traffic is
balanced.

¢ Business Managers—Determine impact of product launches per market or per site.

WAE Live Menu
S,

Note  The availability of menu items depends on the licenses purchased.

Menu Description

Explore Enables you to interactively navigate to objects and their properties to view their current or historical state
through tables and graphs. You can also use the selections for input when creating reports from Analytics pages.

Inventory |View a hierarchical representation of the current hardware in your network.

Analytics e The Configure Report page provides access to creating multiples types of reports, including health, traffic,
deviation, and other user-specified (ad hoc) details.

e The Reports page lists those reports that you have named and identified for frequent use. You can rerun
reports, access report results, and schedule reports to run at specified dates with results mailed to you or
others.

e The Report Log page lists all reports previously run, including both named and unnamed. You can rerun
reports and access report results. This page lists each report’s job ID, which is required information for
importing traffic reports into the WAE Design GUI.

Map Displays a physical topology (weathermap) in near-realtime to show what is currently happening in the network.
Additionally, there are high-level health panels, and you can drill down to see more detailed information.

Settings If you are logged in as an administrator, enables you to perform administrative tasks, such as adding users or
creating new properties. For more information, see the WAE Live Administration Guide.

Related Topics

o WAE Design Integration and Development Guide
o WAE Live Administration Guide
e WAE Network Visualization Guide
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CHAPTER

Objects, Properties, and Data

The Explore and Analytics components enable you to navigate to and report on information about
objects and their properties. You can also navigate to some of these details from the Map page. This
information is stored in a time-series optimized datastore that obtains data through the plan files.

Note  Available objects and properties depend on the licenses purchased and how WAE Collector is
configured. This guide references all possible shipped objects and properties.

¢ Objects—Network elements discovered and whose information is displayed in WAE Live. Objects
include interfaces, interface queues, nodes, LSPs, and demands. When reporting, these objects can
be grouped so that you can aggregate their properties.

¢ Properties—Object attributes that are tracked in and retrieved from the datastore. These properties
appear as column headings on the Explore page.

If you have an administrator role, you can configure new objects properties. For information, see the
WAE Live Administration Guide.

If you are in an Explore or Analytics page and do not see an expected user-defined property, refresh
the browser.
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W RawData
Table 2-1 WAE Live Objects and Properties
Object Properties
Demands e Destination Path e Source
e IGP Metric Path Metric e Tags
e Maximum Latency Service Class e Traffic
e Name
Interfaces e Admin Status Metric ¢ Remote Node
e AS Name e Tags
e (Capacity Node e Type*
e Description Operating Status e Traffic In
e Dropped Packets Out Packets In e Traffic Out
e Error Packets In Packets Out e UtilIn
e Function Remote AS e Util Out
e [P Address Remote Interface * The Type property appears as a number 1-6.

For a description of each of these interface
types by number, see the Explore chapter.

Interface Queues

Error Packets In
Error Packets Out

Interface Queue

Node
Packets In
Packets Out

Traffic In
Traffic Out

LSPs e Actual Path Remote Node e Source Node
¢ Admin Status Setup BW e Tags
e Name Shortest TE Path e Traffic
e Operating Status
Nodes e CPUO Meml e SNMP Error
e CPUI Model e Tags
e Function (0N} e Vendor
e [P Address Name
e MemO

Raw Data

The basis of property values is called raw data. Property values within a plan file are stored (in the
datastore) as raw data points in WAE Live. When a property value changes, a new raw data point is
stored.

For instance, if a plan file is generated once a day with updated traffic, each week would comprise 7 raw
data points. However, if one plan file is generated per hour for updated traffic, each week would
comprise 168 raw data points (24 hours * 7 days).

This raw data appears in graphs, showing data over time. The raw data also appears in Explore tables,
where each column represents the most recent property value.

Cisco WAE Live 6.3 User Guide
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Note  All traffic is displayed in Mbps.

Related Topics

e Graphs chapter

e Tables and Filters chapter

e Explore chapter

¢ Configuring Reports chapter
e Map chapter
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CHAPTER

Graphs

Access: WAE Live > Explore and report outputs

Description lcon

Graph a single table entry.

Graph all objects in a table, which is located above all the individual graph icons. -
[llg)

Graphs show properties over time, enabling you to determine when significant events occur. For
example, you can graph traffic to identify unexpected shifts, visualize growth trends, and determine
whether traffic returns to normal levels after maintenance. Drops in traffic could indicate a routing
problem. Figure 3-1 shows an example of a single Explore graph of an interface’s Traffic In and Traffic
Out over the last week.

Note that these graphs are available both through the Explore pages and as part of the output generated
by most reports.

Cisco WAE Live 6.3 User Guide ]



Chapter3  Graphs |

B Graph Options

Figure 3-1 Example Single Graph of Interface Traffic In and Traffic Out Properties
Graph Different Graph Different Open Graph in
Properties Time Range New Window
[ | |
v v —
» Show Properties * Time Range: Last 1 week(s)

Interfaces: 192.168.243.0/24:bgppsn~to_am_nyc?2_equinix

Traffic In and Traffic Out

3002.25 », &)
> . "
2 TraffOut Raw: 2798.27
H

Legend —> Traffin Raw — TraffOut Raw

381603

Show Raw Data
In CSV Format

Graph Options

e Show Properties—Select which properties to show in the graph.

e Time Range—Graph properties across a different time range. After changing the time range, you
must click Redraw Graphs.

e Data Gap—Data Gap- A measurement of the time delta between two consecutive data points. This
delta determines whether the difference between the two data points should be shown as a gap in the
traffic. Enter the value in hours, minutes, and seconds.

Measurement gaps can occur when objects appear and withdraw from a network, when circuits
become operational and non-operational, or when demands appear or disappear due to traffic
fluctuations. While these are normal conditions, you might find the data easier to read if you adjust
the Data Gap value.

Reports include an aggregate measure, for example P95 over one day. When measurement gaps span
the aggregation period, the graphs keep the aggregate at a constant rate using the last aggregate
calculation. The result is a continuation of a graphed line when possibly there is no data due to
network maintenance or failures. You can show these gaps by adjusting the Data Gap value.

e Graph Mode—When graphing multiple objects, change the graph mode. For more information, see
the Graph Multiple Objects section.

— One property per object.
— One property across multiple objects in either an overlay or a stacked manner.

e Hide and show graphed properties—Click the property or graphed value (such as a trend) in the
legend below the graph to toggle it on and off.

Cisco WAE Live 6.3 User Guide
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Graph Multiple Objects W

kit Ly |
, : | |? 'ﬂ |' ﬂ 'I
Mgl YV A S|

— CPUD Raw — CPU1 Raw

1 lkuﬂll_llillr_\ﬁ!lml_ [ ".:.ﬁpliir'lﬁu"lp

381610

— CPUO Raw

e View values—View values of any point in the graph by hovering your mouse over a data point.

e (CSV data—To list the graphed information in CSV format, click the CSV link below the graph. You
can then use the browser tools to save or send the data, or you can cut and paste it to a file.

31611

¢ Magnifying glass—Enlarge or decrease the size of the overall graph.

e Zoom—Zoom into a specific segment of the graph. Click and hold the cursor at the beginning of the
range, and then drag it to the end point of the segment you need to enlarge. Zooming helps better
read the reported data, such as when a deviation occurs.

Graph Multiple Objects

You can graph all objects by clicking the Graph All icon at the top of the table. Thereafter, there are three
available graph modes.

¢ Individual objects
e Overlay by property
e Stack by property

|nn)

Graph by Individual Objects

Individually graphing each property per object is useful when you want to see all of the data for an object
in one place. For example, this mode makes it easy to compare inbound and outbound traffic for a
particular interface. Figure 3-2 is an example where the Traffic property for three LSPs is graphed using
the Individual Object graph mode.
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Figure 3-2

Example of Graphing Individual Objects

One Property
Per Object

TrafMic

Traffic

Mbps

Traffic

Mbps

LSPs: ap_bei bb1_ap_hk_bbi~ap bei_bb1

) NS N h\\_/ﬁ\k//\\_/’;R.u/ﬁ

Trafl Raw

LSPs: ap_tok_bb1_ap_hk_bbi~ap_tok_bb1

VU AVA UV N

— Trafi Raw

LSPs: ap_hk_bb1_ap_hk_bb2~ap_hk_bb1

| . A
NN ,f”"ﬁ“\__..,'/ N NS NN

Trall Raw

Graph by Multiple Objects

You can graph a single property for multiple objects either by overlaying them or by stacking them.
Figure 3-3 shows an example of each using the same data (Traffic property, time frame, and LSPs) as

was generated for Figure 3-2.

e Opverly by property—Overlay a single property for multiple objects in one graph. This is useful
when you want to compare a single property across multiple objects. For example, if you want to
compare inbound traffic data for all interfaces, overlay graphs make it easy to see which interfaces

are carrying the most traffic.

e Stack by property—Stack a single property for multiple objects in one graph one on top of the other.
The size of each colored area is per property and is proportional to the total, which is useful when
comparing a single property across multiple objects over a given time. For example, you could use
stacked graphs to compare how much CPU each node is utilizing at any given time.
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Figure 3-3 Example of Overlay and Stack Graphs
One Property Per |maff raw
Multiple Objects Overlay by Property
3 - ' | | |
J% : o {d_L_,,a"F1\1\x;H_JfJJl‘“‘~¢H__,t"‘-i‘
“ Sep. 18 Sep.19 Sep. 20 Sep. 21 Sep. 22 Sep. 23 Sep. 24
— Obj_1 — Obj_2 0bj_3 — Obj_4 — 0Obj_5 Obj_6 Obj_7 0bj_8 0bj_9 — Obj_10
Traff Raw

Stack by Property

>
).

i
) >

1] -
Sep. 18 Sep. 19 Sep, 20 Sep. 21 Sep, 22 Sep. 23

8 0bj_1 @8 Obj_2 B8 Obj_3 @ Obj_1 B8 0bj_5 M Obj_6 M9 Obj_7 M Obj_8 " Obj_o MM Obj_10

381601

| O% | Obj_3CSY | Obj_4 CSV | Obj_5CSV | Obj_6 CSV | Obj_7 CSV | Obj_8 CSV | 3|

WAE Live assigns each object an object ID and graph color, and lists this association below each graph,
thus identifying which data belongs to which object (Figure 3-4). As you move your cursor over the data
points, the sum of the property values is listed along with the value of each object. To open or close the

Object Reference section, click its arrow.

Figure 3-4 Reading Multi-Object Graphs

» Object Reference

Chject ID Ohject Name
ap_hei_bb1_ap_hk_bb1-ap_bei bk1
ap_tok_bb1_ap_hk_bb1-ap_tok_bb1
ap_hk_bb1_ap_hk_bb2-ap_hk_bb1

2013-09-24 0730 (UTC)

Total 33.92 €———SUum

Mbps

| o opj 1 mob 2 mobj 3

A A

381606

Related Topics

e Objects, Properties, and Data chapter
e Tables and Filters chapter

e Explore chapter

Cisco WAE Live 6.3 User Guide
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M Related Topics

¢ Configuring Reports chapter
e Map chapter
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Tables and Filters

Access: WAE Live > Explore and report outputs

Tables in the Explore page enable you to view and filter objects based on their current property values,
as well as graph property values (raw data) over time and navigate to related objects. Additionally, all
reports generate output in a table format.

Each table lists current information for the selected object type (rows) and properties (columns).

Gear Tool Options

To select any of the following options, click the gear tool.

Common

¢ Columns—Click to select which report columns to show in the output. If a column check box is gray,
then you cannot turn it off. These non-optional properties always appear in the left-most columns of
the output.

¢ Download CSV—Export the table in a tab-delimited format.
e Rows per page—Select the number of objects to show per page in the table.
Explore Page

e Show Inactive <Object>—Show (checked) or hide (unchecked) all objects that have not been
detected in the last four hours.

e Show Only Selected—Show only those objects that are selected in the far left column of the table.

e Types—Specify the interface type so that you do not show duplicate traffic statistics. This option is
applicable only on the Interfaces page.

Note If you select specific interface types from the Explore Interfaces page for use in a report, then the report
is only on those interfaces of those selected types. If you select Interfaces as the Object from a Configure
Report page, then the report is run on all interfaces regardless of their type.

Report Output

e Edit—Open the Configure Report page to rerun or reconfigure the report to run again.

Cisco WAE Live 6.3 User Guide
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W Filters

e Save As—Name or change the name of the report.

e Permalink—Save the report’s URL.

Filters

Filters are available in most of the tables.

e Filter text—Filter one or more properties to narrow the list of objects you are analyzing or reporting.

e (lear filter—To clear all filters in all columns, click the Clear All Filters icon. To clear one of
multiple filters, remove the text from the column in which the filter appears.

e Filter values—Enter a value in one or more <filter text> fields, and press Enter (Return).
— For non-numeric properties, you can filter using these methods.
— Partial or full strings
— Regular expressions
— isNotNull or isNull

Example: If you enter LON as the filter in the Interfaces Node column, only interfaces with
nodes that include LON in the node name are listed.

Example regex: In this example, the descriptions contain “to="to identify a region into which
an interface is going. To search for all descriptions that contain a to= value that starts with
“north” (so it will include iterations such as north, northwest, and northeast) or the description
contains a to= value of “south” (but not other iterations, such as southwest), enter the following
regular expression.

to=northlto=south$

Example regex: In the Description field, to find all descriptions that do not contain the words
“test,” “trial” or “alpha”, enter the following regular expression.

I~testltriallalpha

If, however, you want to search on descriptions that contain any one of these three fields, enter
the following.

testltriallalpha
— For numeric properties, you can filter using these methods.
— Complete value
— Operators, such as >, <, and =
— isNotNull or isNull

Example: If you enter >11894 in the Interfaces Traffic Out column, only interfaces with
outbound traffic that is greater than 11894 are listed.

Cisco WAE Live 6.3 User Guide
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Related Topics

e Objects, Properties, and Data chapter
e Graphs chapter

e Explore chapter

e Inventory chapter

e Traffic Reports chapter

¢ Health Reports chapter

e Deviation Reports chapter

e Ad Hoc Reports chapter

Cisco WAE Live 6.3 User Guide
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CHAPTER

Explore

Access: WAE Live > Explore

The Explore component enables you to interactively navigate current network data and retrieve historical
object performance data. For example, you can use Explore to do the following.

e Identify which LSPs are currently off their shortest TE paths.

e Determine which LSPs currently are going through a specific interface, or which IP address carries
a specific interface and the historical changes on that interface.

e Determine whether IP address or metric changes have occurred on an interface during the last week.

The Explore page (Figure 5-1) enables you to view and filter objects based on their current property
values, as well as graph property values (raw data) over time and navigate to related objects.

Additionally, the Explore page enables you to view summaries of the named reports over a period of
time. Interactions with this report summary is the same as with the objects. See the Reports section.

Note  For instructions on how to use graphs and tables, see the Graphs and Tables and Filters chapter,
respectively.

To view Explore information for a specific network, select it from the Network list (top left). If there is
only one network configured, the word “default” appears.
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Bl Example: Explore LSPs

Figure 5-1 Example Explore Interfaces Table
@ Columns
Show Inactive Nodes
Show Only Selected Graph All
Objects
= Rows Per Page
Each Column Is a Property & Download CsY
Interfaces Interfaces Y Interface Queues ‘ Nodes T LSPs ‘ Reports
MNode Name Capacity  IP Address Lot 4
er filter text filter text | filter text Clear _> x
B i EECTIEREER LR R PR R e - Filters Related
1 erlwdc GigabitEthernet0/3/0 1000 10.128.0.78/30 % O il > f— Objects
J erl.van GigabitEthernet0/2 1000  10.128.20.10/30 Notes —» O il e loalInterfacs |
. erl.sjc.cisco.com  GigabitEthernet0/3/0/1 1000  10.128.0.162/30 O il
b = Remote Interface
T T LSPs
Raw Time-Series Graphs
Select Most Recent
Objects Property Values
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Example: Explore LSPs

This example shows how to find the three LSPs with the highest setup bandwidth that are currently going
through interface ae0.0 on node FRA-BB2 and that exceed 2 Gbps of traffic. It then shows how to find
the source node of the LSP with the highest setup bandwidth with these parameters.

Actual Path Traffic
FRA-BBZ.320.0 =>2000

381599

Step1  On the Explore LSPs page, enter “FRA-BB2.ae0.0” as the filter in the Actual Path column.
Step 2 In the Traffic column, enter “>2000" as the filter, and then press Enter (Return).

Step3  Click the Setup BW column heading to toggle the list in descending order.

Step4  Click the Related Information icon (arrow) of the LSP with the highest setup bandwidth.

Step5  Select Source Node. The resulting table is the source node of the LSP with the highest setup bandwidth
that is currently going through interface ae0.0 on node FRA-BB2 and that exceeds 2 Gbps of traffic.

Cisco WAE Live 6.3 User Guide
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Reports

The Reports Explore page provides a report summary on the total number of lines in a report and the
number of lines when run against a user-specified filter. Only named reports and only the most recently
run reports are recorded.

This high-level report trend can be an indicator of the network’s health. For instance, if you run a node
health report every week and filtered the percentage of time CPUs were over a given threshold, this table
could show the number of nodes surpassing this threshold improving or worsening over time. If the
number of nodes passing the threshold was increasing, it could be an indicator that the network is
running hotter and you need to buy more nodes.

Example: This example report table indicates that in the last LSP Hop Changes report, only 3 out of 36
possible report entries were generated. For the Semi-Annual Node Health report, there were no lines in
the report of possible 241 rows once filtering was applied.

Total Lines Definition ID Report Name Run Time Total Lines After Filter

36 44 SP Hop Changes 13674

383329

241 21 Semi-Annual Node Health 7625

Explore Table Options

Show More Data

Actual Path

¥ 4 hops

- {AP_HK_BEB1|2e0.0}
- {AP_HK_BB2|50-0/2/1.0}
- {AP_TOK_BB1 | xe-0/2/0.0}
- {AP_SYD_BB1 | 2e0.0} g

]
o0

Cell information that is blue or cell data that has a small arrow by it can be expanded to show more data.
Following are examples.

¢ Count column—Click a blue number to see a list of objects included in that count value.

e LSP Actual Path column—Click the right arrow of an actual path in an LSPs table to see an
expanded list of its individual LSP hops. Click any hop to show it in the Nodes table.

¢ Demand Path column—Click the right arrow of a path in a Demands table to see an expanded list of
individual hops. Click any hop to show it in the Interfaces table.

Cisco WAE Live 6.3 User Guide
| ==



Chapter5 Explore |

M Explore Table Options

Selections

e Per-row check boxes—Select the check box next to the desired object. This is a toggle that selects
or deselects a single object.

When running reports, these selections are the default filters. For information on report filters, see
the Configuring Reports chapter.

e Top check box—This is a toggle that selects or deselects all objects of the type you are viewing. For
example, you can select all demands or all nodes.

If you have previously filtered to a subset of objects, this top check box applies only to them.

Graphs

e Graph all icon—Graph the data for all objects in the table.

e Graph icon—Graph raw data of an object. From here, you can also list the raw data, which you can
then save or send to others.

il | Graph All Objects

¥ | Clear All Filters

i

il Graph Single Object

3@

For more information, see the Graphs chapter.

Add Notes

You can add notes to the object rows in the Explore tables. All other users can read the notes and add
further information to them. This enables multiple WAE Live users to share information that others
might need to know, such as notes on interfaces that are reaching capacity or notes on when nodes are
temporarily down for maintenance.

® | 44— Has Text
| 4—— Empty

404577

Notes that have information show as a solid blue to signal there is something to read.

To add a note, read a note, or add content to an existing note, click the Note icon.

Find Related Objects

To find objects that are related to an object of interest, click the related objects (arrow) icon associated
with the object of interest, and then select the information you need from the list. The Explore page
changes to list the related information.
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Explore Table Options

Example: To find destination node information for a specific LSP, click this icon associated with that
LSP and select Destination Node.

Gear Tool Options

The same set of gear tool options are available across all Explore pages with the exception of the
Interface Type. To select any of the following Explore table options, click the gear tool.

¢ Columns—Click to select which properties appear as column headings. All available properties are
listed. If a column (property) check box is gray, then you cannot turn it off. These non-optional
properties always appear in the left-most columns of the table.

~

If you display the Type column, the property shows as number. Following is a description of each
of these interface types and the number associated with them in the Type column.

(1) Individual physical interface—An interface that is not in a LAG and does not have an IP
address. These interface names do not have a decimal.

Example: so0-0/2/2, g2/0/0

(2) Individual logical interface—An interface with an IP address that is not in a LAG. These
names might have a decimal.

Example: et-0/1/2.0, g2/0/0
(3) LAG logical interface—An interface with an IP address that contains member interfaces.
Examples: ae0.0, Bundle-Ether1, Port-Channel7

(4) LAG physical interface—The physical representation of an aggregated interface to which a
LAG logical interface (such as ae0.0) is assigned.

Example: ae0 for Juniper interfaces
(5) LAG member interface—An interface that is in a LAG.
Example: g2/0/0

(6) Unknown—None of the above interface types

Show Inactive <Object>—Show or hide all objects that have not been detected in the last four hours.

Show Only Selected—Show only those objects that are selected in the far left column of the table.

Rows per page—Select the number of objects per page to show in the table.

Download CSV—Export the table in a tab-delimited format.

Types—Specify the interface type so that you do not show duplicate traffic statistics. This option is
applicable only on the Interfaces page.

Note If you select specific interface types from the Explore Interfaces page for use in a report, then the report
is only on those interfaces of those selected types. If you select Interfaces as the Object from a Configure
Report page, then the report is run on all interfaces regardless of their type.
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Bl RunReport

Run Report

Select the objects on which you want to run a report, and then click the Run Report button. The
Configure Report page appears. For more information, see the Configuring Reports chapter.

Related Topics

e Objects, Properties, and Data chapter
e Graphs chapter
¢ Configuring Reports chapter
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CHAPTER

Inventory

Access: WAE Live > Inventory

The Inventory pages show inventory data in different views to help you best find answers about your
hardware inventory. The views include Tree, Table, Summary, and Availability.

To view inventory information for a specific network, select it from the Network list (top left). If there
is only one network configured, the word “default” appears.

The Inventory Tree page provides a hierarchical representation of the current hardware in your network.
It also provides information on how the hardware is interconnected within the chassis. This filterable
table enables you to search for these interconnections. For instance, you can find a specific chassis by
filtering on its name or you can navigate to connected interfaces.

Node

filter text

AF_CAI_BB1

Chassis
filter text

T1600

rows per page 10 ::J |<< < 1-100f4494 > >>|
Slot Linecard ModuleSlot | Module PortSlot Port Transceiver | Interface AdminStati
filter text filter text filter text filter text filter text filter text filter text filter text x
PD-1CE- CFP-
0 et-0/0/0
CFP-FPC4 100GBASE-LR4
. PD-1CE- eto1/0/0 CFP- -
CFP-FPC4 s 100GBASE-LR4
2 T1600- 0 PD-5- 0 xe-2/0/0 SFPP-10GE-LR ~
FPC4-ES 10XGE-SFPP o
1 xe-2/0/1 SFPP-10GE-LR ~ =
a8
2 xe-2/0/2 SFPP-10GE-LR -~ §

One key use case is for determining if there are any empty slots available to accommodate future growth.
For instance, if you need to add five10-GB interfaces on a specific router (node), you can determine how
many, if any, empty module and port slots you have. This can further help you plan for future hardware
expenses.

To determine if there are available modules or ports, enter “empty” as the column’s filter. If there are no
results, then there are none available. Returned results indicate exactly which slots are available.
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W Table

I Description: PLIM Optics Port Slot
Mame: 3

Mode: 192.168.244.0/24:BgpPsn
Parentld: 7490160

SHMPI: 55204457
SerialMumber:

Type: ModuleSlot

3

383333

To find detailed information about any piece of hardware, hover over the top of it. Note that the Parent
ID is the SNMP ID of a physical child asset. For example, a slot’s Parent ID is the SNMP ID of the
chassis to which it belongs.

To see the Explore data for an interface or a node associated with a port, or to see more details on the
node itself, use the Related Info icon (arrow on the far right).

Using Notes

When the Port and the Interface Admin Status columns are populated, you can add notes by clicking the
[Add] link in the Notes column. This can be useful for communicating with peers. For instance, you
might add a note that a port is reserved for a specific project or that it is faulty.

All users can see the notes, read the history of the notes (that is, each edit made to the note), and edit the
notes. To edit or read the history, click the note itself to open a dialog box with Edit and Show History
links.

Notes cannot be deleted.

Table

The Inventory Table page lists all physical elements in the network. While you can filter on any column
to find network elements, the predominate use case is to find serial numbers by using the filtering
capabilities in the Serial Number field.

Inventory Table

Name Type Node SNMP ID Serial Number Description Parent SNMP Id
filter text filter tex  [filter text filter text  filter text filter text filter text

7600 Chassis  AF_CAILERT 1 LIN4S00W

7600-ES+4TG3C  Linecard AF_CAI_ER1 13 106CFDOH 12

7600 Chassis  AF_JOH_ER1 1 4LDZU2)8

7600-ES+4TG3C  Linecard AF_JOH_ERT 15 OBNZYAGV 14 é
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Availability

Note

The Inventory Availability page enables you to determine how many slots are available (free to use) per
node (router), per linecard, and per module. One use case would be to identify how to consolidate empty
slots and empty ports.

Each hardware element that can host is considered to be a “slot.” If a chassis or linecard does not have
available slots, of if a module does not have available ports, it is not listed in their respective tables.

If a linecard is modular, it represents the number of slots it can hold, not ports.

The Modules table shows the number of ports, available ports and ports that are down. A port is
considered down if its Operational Status is down.

node
CHI

AM_CHI_BB1
AM_CHI_ER1

AM_CHI_ER3

Summary

model vendor serialnumber number slots available slots ™
filter text filter text filter text filter text filter text

CRS-16/S Cisco OQAYRLV6E 16 10

ASR-9010-AC-E Cisco TE9YCKIX 8 7 =
ASR-9010-AC-E Cisco SWVEEM3A 8 7 %

The Inventory Summary page gives the count of hardware elements in the network on a per element
basis. One use case would be if a vendor announced that a linecard were being deprecated, you could
use this table to determine how many linecards you would need to replace. You could further understand
the impact by filtering to the model in the Availability page to determine how many slots are available,
thus indicating where you would need to move traffic.

Combined with information on the cost of the hardware, this Summary table could help you estimate the
total cost of the network.

Hardware Inventory Summary

type model vendor count ¥
filter text filter text Cisco filter text
Linecard Empty Cisco 858
Transceiver AFP-10GLR-OC1925R Cisco 664
Transceiver T0GBASE-LR SFP+ Cisco 360 é
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Columns

Available Slots—Number of slots that are not being used.
Chassis—A descriptive or exact name of the router type, such as ASR9000.
Count—Number of network elements of given type.

Interface Admin Status—Administrative status of the interface connected to the port. Values are Up
for active or Down for inactive.

Interface Description—Optional description of the interface connected to the port.

Linecard—A printed circuit board that contains ports or modules (which in turn, contain ports). A
linecard plugs into a chassis slot.

Model—A particular unit of hardware that identifies its style or type.

Module—A self-contained hardware element that contains ports and plugs into a chassis or a
linecard slot. An example module name is 10-port 100-Gbps LSR. A module is also sometimes
called a PIC.

Module Slot—A slot in a linecard for holding modules.

Name—The name of the hardware identified in the Type column. If applicable, such as for chassis
and linecards, this is the model.

Node—Router name, such as 168.243.0/24:BgpPsn.
Number Slots—Total number of slots an element contains (both used and unused).

Parent SNMP ID—Hardware has a parent-child relationship based on where the object resides
within the router. The chassis has no parent and is considered the root object. Other than the chassis,
each object has one parent and can have one or more child objects. The Parent SNMP ID is the
identifier of the parent.

Port—A socket that accepts a plug. For example, cables are plugged into Ethernet ports. An example
port name is GigabitEhternet0/1/0/7.

Port Slot—A slot in a module for holding physical interface ports.

Serial Number—A unique series of numbers and letters assigned by the vendor to each hardware
element. An example serial number is X8XP16J2.

Slot—Each hardware element that can host is considered to contain slots. Chassis have slots that
contain linecards. Linecards have slots that contain ports or modules. Modules have slots that
contain ports.

SNMP ID—ID of the hardware element as described by the router.

Transceiver—An electronic device or circuit that transmits and receives analog or digital signals.
Transceivers are connected to ports. An example name is DWDM Xenpaks.

Type—The hardware element category. For example, chassis and module are both types of
hardware.

Vendor—The company that sells the node (router).

Related Topics

Tables and Filters chapter
WAE Platform Configuration Guide (inventory collection)
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Configuring Reports

Access: WAE Live > Analytics, click New Report
Access: WAE Live > Explore, select objects, and click Run Report
This chapter describes the following.
¢ Configuring Reports, including Required Report Tabs and Running Reports.
— Grouping Objects describes the options for grouping objects in the report results.
— Time Aggregation describes this feature, which is available in Traffic and Ad Hoc reports.

— Naming Reports and Applying Filters and Sorting Named Reports are applicable to reports that
you want to schedule or email.

e Report Output, including how to use the Gear Tool Options.

To configure reports for a specific network, select it from the Network list (top left). If there is only one
network configured, the word “default” appears.

Use Cases

The Analytics pages enable you to generate traffic, health, ad hoc, and deviation reports. These report
tools give you a series of options, such as the following, that enable you to customize the reports.

e On which objects are you creating the report?

e What are the properties on which you are reporting?

e What is the time frame for the report? Do you need to project a trend out farther than that time?
e Are you reporting on individual or grouped objects?

e Are you applying time aggregation operations, and if so, what are they (for example, P95 or
average)?

Configuring Reports

Required Report Tabs

e Report Type—The type of report to be run.

Cisco WAE Live 6.3 User Guide
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MW Configuring Reports

e Object—The object type on which the report is generated.

e Filter—The subset of objects on which you are reporting. For instance, if the object is an LSP, you
can filter to report on all LSP destinations, or you can further refine the report to one or more specific
destinations.

You can specify filters from the drop-down lists, or you can base them on selections in the Explore
tables, as follows.

— Select the property from the Latest Value list, and then refine it using the second list. This
enables you to run the report on all objects based on the selected property or on all objects
matching the refined property value.

Select Property Refine to
From List Specific Value
Q@ Latest value of Remote AS E| is 64512 "‘ %

— Select the properties of only those objects that are currently selected in the associated Explore
page. For instance, if you have three LSPs selected in an Explore page, the filter defaults to
those three selected LSPs.

Optionally, you can click the Edit link to change these selections, which takes you to the
Explore page. For more information, see the Explore chapter.

Latest value of Remote AS E is 64512 E

@ Selected in Explore (23 Objects) Edit...

T !

Use Current Edit Explore
Explore Selections Selections

381643

~

Note If you select specific interface types from the Explore Interfaces page for use in a report, then the report
is only on those interfaces of those selected types. If you select Interfaces as the Object from a Configure
Report page, then the report is run on all interfaces regardless of their type.

e Report Time Range—The time frame for which the report is generated. Select the time range using
one of these methods.

— Select the range from hours to years and enter a value, for example, 1 month. This option
captures a range from the current time backwards.

— Select a custom date range. You can enter the range in yyyy-mm-dd hh:mm:ss format, or you
can select dates from both calendars.

Cisco WAE Live 6.3 User Guide
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Grouping Objects

The traffic and ad hoc reports support the ability to group (or aggregate) a set of objects and sum their
property values. In the resulting report table, each row represents a group of objects. The columns
represent the aggregated values for each group.

Group By
None
Overall _
) SourceNode v
And By Remote Node '| I, j

e Overall—Groups all objects in the report into one row of data. For instance, you can group all
interfaces to determine their overall traffic. The data in that row is the sum of all interfaces
combined.

e Group by one property—Group all objects that have the same value for the selected property
together. The resulting report shows one row for each grouped property and the data in that row is
the aggregate for that property. For example, if you select LSPs as the object and then group them
by Source Node, the resulting report includes one row for each source node. The data in that row is
for all LSPs that are sourced from that node.

e Group by multiple properties—Further segment a group of objects based on another property
selected after clicking the Plus icon. The resulting report shows one row for each set of grouped
properties within its parent group. For example, if you group LSPs by their source node and
secondly by their remote (destination) node, the report aggregates data for all remote nodes that have
the same source node. In effect, this example grouping would create a traffic matrix.

Example: Figure 7-1 shows a report generated three times: one without grouping objects, one with
objects grouped by nodes, and one grouping first by nodes and then by metric. Notice that both the
Capacity and the Latest Traffic Out (P95) columns adjust according to whether and how the objects are
grouped.
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Figure 7-1 Example Effects of Grouping Objects

No Grouping

Noda . Name Capacity Latest Traffic Out (P95) Trend Value
filter text filcer text filter text | filcer text

EUAMS_AMSIX  TenGigEQ/1/0 10000 700.24

EL_AMS_AMSIK lentaigkbn/0/ 0000 b9E.84

EU_AMS_AMSIX  TenGigE0/0/2 10000 698.26

EU_AMS_AMSIX lenGigbn/0M 10000 79228

EU_AMS_ANSIX  TenGigEo/0/0 10000 699.00

EU_AMS_AMSIX lenGigkn/0/4 10000 79123

Group Objects by One Property

Noda Count Total Capacity Latest Traffic Out (P95) Trand Valua
filter taxt filter t¢  filter text filter text

EU_AMS_AMSIX & &0000 438545

EU_AMS_AMSIX 2 15 150000 2234919

EU_AMS_BE1 12 120000 2800092

Group Objects by Two Properties

Noda Metric Count Total Capacity Latast Traffic Cut (PO5) Trend Value

filter text filter te  filter t¢  filter text filter text

EL_AMS_AMSE 123 4 A0000 2797 81 g

EU_AMS_AMSIX 10 z 20000 1582.28 ©
©

Time Aggregation

The traffic and ad hoc reports support time aggregation features that aggregate multiple property values
into a single value for a given time range. For instance, you can aggregate maximum raw data values for
traffic on a weekly basis.

Time aggregation options vary depending on the report and property type. They include P95, average,
maximum, minimum, last, and count. (P95 is the value 95% of the time.)

Time aggregation operations are applied to raw data. For a description of raw data, see the Objects,
Properties, and Data chapter. For more information and examples of aggregating data in the reports, see
the Traffic Reports and Ad Hoc Reports chapters.

Running Reports

You can run a report from any of the following locations.

e Run new reports.

— From either the Analytics > Reports page or Analytics > Report Logs page, click the New
Report button.

— From the Explore page, select objects and click the Run Report button.

e Rerun existing reports (with existing or changed parameters).
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— From the Analytics > Reports page, click View > Run, which runs immediately with the same
parameters. To keep or change the parameters, click View > Run or click the name in the Report
Name cell.

- From the Analytics > Report Log page, to keep or change the parameters, click View > Edit or
click the name in the Report Name cell.

~

Note  If you need to email the report, you must give the report a unique name when you run it (see the Naming
Reports section).

Naming Reports

To run the report with a saved name, click the Save & Run button after configuring the report. By giving
the report a name, you automatically add it to the Analytics Reports page where you can easily identify
and schedule it for future use.

To run the report without giving it a name, click the Run button after configuring the report. If you do
not save the report with a name, it is given a default name with the format Report Type-Object
Type-Definition ID. Reports that use a default name appear only on the Analytics Report Log page.

To change the name of an existing report, there are two options.
e From the report output page, select Save As from the menu available through the gear icon.

e Run and save the report again with a new name. This overwrites the existing report name.

Applying Filters and Sorting Named Reports

You can apply filters and sorting to a named report so that it displays according to these filters and
sorting each time you open or run the report. Thereafter, you can schedule email alerts to be sent when
these conditions are met using the Reports page.

These saved report parameters do not affect the generation of the report. Rather they affect what is
displayed in the output (based on the filters that were applied), how the information is displayed (based
on how the columns were sorted), and if scheduled appropriately, whether the report is sent via email.

Step 1 Run and name the report. See the Naming Reports section.
Step2  On the report output page, apply filters and/or sorting.

e Enter a value in one or more “Filter Text” cells at the top of a table column, and press Enter (Return).
See the Tables and Filters chapter for more details.

e To sort the results of a property in a specific order, click its column heading one or two times.

Step3  Save the filters and sorting by clicking the Save icon.

Save
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Report Qutput

The output of all reports is in a table format that can be exported, and most reports enable you to graph
the resulting data. For information on how to use tables and graphs, see the Tables and Filters and Graphs
chapters, respectively.

You can view reports from two primary locations, both accessed from Analytics.
e Report Log—List of previous reports that you can view or rerun.

e Reports—List of uniquely named reports that can be scheduled and emailed.

Gear Tool Options

From a report’s output page, to select any of the following options, click the gear tool.

¢ Edit—Open the Configure Report page to rerun or reconfigure the report to run again.
e Save As—Name or change the name of the report.

e Columns—Click to select which report columns show in the output. If a column check box is gray,
then you cannot turn it off. These non-optional properties always appear in the left-most columns of
the output.

e Download CSV—Export the table in a tab-delimited format.
e Permalink—Save the report’s URL.

e Rows per page—Select the number of objects per page to show in the table.

Related Topics

e Objects, Properties, and Data chapter
e Explore chapter
e Creating new reports
— Traffic Reports chapter
— Health Reports chapter
— Deviation Reports chapter
— Ad Hoc Reports chapter
e Viewing, re-running, and scheduling reports
- Reports chapter
- Report Log chapter
e Map chapter
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Traffic Reports

Access: WAE Live > Analytics, click New Report, and select Traffic Report Type
Access: WAE Live > Explore, select objects, and click Run Report

Traffic reports enable you to trend interface traffic, LSP traffic, and demands over a specified time range.
These trends are based on time aggregations of the raw traffic data (for example, P95 traffic per week).
The resulting report tables provide additional information, such as the number of aggregated objects on
which the trending is computed. They also list the percentage at which the traffic is growing or shrinking.

Additional options are available, as follows.
¢ Projection options, which are based on the trends.

— Carry these historical trends into the future to determine at what date the traffic would be
projected to surpass a given threshold.

— Determine the state of traffic at a specific date.

e Group objects to trend aggregated (summed) traffic data. For information on the effects of grouping
objects, see the Configuring Reports chapter.

Grouping objects is useful for aggregating traffic that can then be imported into WAE Design for use
in creating growth plans. For more information, see the WAE Design Integration and Development
Guide.

To configure reports for a specific network, select it from the Network list (top left). If there is only one
network configured, the word “default” appears.

Example: This basic LSP traffic report shows the LSP traffic aggregated on a daily P95 basis. The trend
values, growth, and trend line are all fairly even, and the traffic is spiking upwards with some regularity.

Cisco WAE Live 6.3 User Guide ]



Chapter8  Traffic Reports |

Projecting Traffic

Name SourceMNode Latest Traffic (P95) Trend Value ¥ Traffic (P95) Growth
filter text filter text filter text filter text
AP_HK_ER1_AP_SYD_ER3 AP_HK_ER1 27.02 -1.52%
AP_MEL_ER3_AP_BAN_ERZ AP_MEL_ER3 27.00 -1.82%
AP_BEI_ER3_AF_CAILER1 AP_BEILERZ  26.99 -1.27%
Trend Line
Aggregated
Traffic | ‘
b
A Y [ ravmml
Raw - |
Data [}
8} ﬁ
Sep.18 Sep. 20 Sep. 22 Sep. 24 g

Projecting Traffic

Project Traffic to Cross Thresholds

One projection option is to project which objects will exceed a specified utilization in a specified future
time range. Once the report is generated, you can graph the historical and projected trend on a per-object
or per-group basis over any period of time. These graphs allow you to visualize the trends and underlying
data. They can show a pattern of when thresholds are surpassed, and they can show threshold violations
narrowed to a single event. For instance, if you set 50% for 2 years using a maximum monthly trend, the
resulting projected threshold tells you when aggregated monthly maximum traffic is expected to exceed
50% of the interface capacity over the next two years.

The resulting graphs display two lines: one showing the trend within the report time period and within
the projected time period, and the other showing the threshold. For an example graph, see Figure 8-1.

Example: If you set 50% for 2 years using a maximum monthly trend, the resulting projected threshold
tells you when aggregated monthly maximum traffic is expected to exceed 50% of the interface capacity
over the next two years.

Example: Figure 8-1 shows an example traffic report generated to determine which interfaces will
exceed 80% of their outbound traffic utilization in the next 5 weeks based on last month’s traffic trend.
The trend is based on aggregating daily P95 Traffic Out. Sorting on Traffic Out (P95) Growth shows that
the TenGigE0/0/0 interface on the AP_TOK_ERS node has the highest percentage of traffic utilization
growth.
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Figure 8-1 Example Date Traffic is Projected to Pass Threshold
Node Name Latest Traffic Qut (P35) Trend Value Traffic Out (FO5) Growth ™ Traffic Out{F95) Threshold Time
ilter tex filter text filter text filter text filter text x
AP _TOK_ERS TenGIgED0/a 247283 79.53% 20131012 10:57:26
ASNGE200:192.168.200.2 to_EU_LON_ERG 297529 58.63% 20121007 050222
AP_HE_EB1 *e-000/2.0 A074.16 5020% 201299.2910:3522
Threshold Trend Line

| —

A
L Date Traffic Is Projected
to Pass Threshold

Mbps

Traffic Out iP95) Trend Tralfic Out (P95} iLincar) Threshold

383337

Aggregated Traffic

Projecting Traffic by Date

One projection option is to project the amount of traffic for a specified date. This is useful for planning
purposes, such as determining when you might need to configure more LSPs or add more capacity.

Example: Figure 8-2 shows an example report output when projecting traffic by date to January 1, 2014.
The report shows that the projected traffic on January 1 will be 16,096.92 Mbps for the same interface

shown in Figure 8-1.

Figure 8-2 Example Traffic Projection by Date
Node Nama Latest Traffic Out (P95) Trend Value Traffic Out (P95) Growth '.Ira"l(Uut-:P:lb:Puoj-.‘ctod.' Util Out (P95) Projected
filter text filter text filer text filter text filter text filter text
AP_TCK_ERE  TenGigbQ/o/g 2472383 79.52% 16086592 160.9/%

TraffOut i

Mbps

Sep. 30 oct, 14

TraffOut Raw — Traffic Out (P95) Trend Traffic Out (P95) {Linear)

383338

Example: Linear Trend Data Aggregation

If one plan file exists per day, and if the month has 28 days, then each interface in the datastore has 28
Traffic Out values for that month. If you run a traffic report on an interface and specify that you want to
trend the weekly P95 of Traffic Out over this month, each week raw data would be aggregated into a

single P95 value. So the first weekly value is an aggregation of seven P95 values. The remaining weekly
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values are an aggregation of the seven P95 values for their respective weeks. The result is a time-series
aggregation with four data points on which the report is trended. These trends are viewable as graphs.
For information on how raw data is collected, see the Objects, Properties, and Data chapter.

Traffic Report Tabs

Required Tabs

e See the Configuring Reports chapter.

¢ Trends—How to compute the trends. See the Trend Fields section.

Trend Fields

WAE Live first calculates the trend at which the property value is moving (its direction and frequency),
and then uses this trend to determine the projected traffic. Set the following parameters to determine how
this percentage is calculated.

¢ For interfaces, trend the traffic on Traffic Out, Traffic In, or both. For LSPs and demands, only
Traffic is available, and it is preselected.

e Interval—The aggregation basis for the trend: P95, Maximum, Average, or Minimum.

e Per—The aggregation interval that is applied to the raw data before calculating the trend. This
interval must be less than the report time range.

e Trending Algorithm—Algorithm used to compute the trend. Both the calculation and the graph
differ, depending on which option you choose. Following is a list of how these graphs are commonly
used.

— Exponential—Commonly used when data values increase or decrease at a constantly increasing
rate.

— Linear—Commonly used with linear data that often shows a steady rate of increase or decrease.

— Logarithmic—Commonly used when data changes by increasing or decreasing quickly and then
stabilizing and leveling.

— Power—Commonly used with data measurements that increase at a specific rate.

Optional Tabs

e Group By—Aggregate the report results by groups. The Overall option aggregates the results for all
objects. For more information, see the Configuring Reports chapter.

In the output, you can expand the group to see its objects by clicking the number in the Count
column.

Example: If you select interfaces as the object and group by nodes, the resulting report includes a
row for each node. The data in that row is for all interfaces connected to that node. To see the names
of interfaces on that node, click the number in the Count column.

¢ Projection—Specify whether to project traffic.
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Related Topics W

— Find <Object> Over ___ % or Mbps—Project the traffic trend into the future based on the
computed trend. WAE Live determines and graphs when the trend will exceed this threshold.
See the Project Traffic to Cross Thresholds section.

- To Date—Project the traffic amount on a specified date. See the Projecting Traffic by Date
section.

Related Topics

e Objects, Properties, and Data chapter
e Graphs chapter
e Tables and Filters chapter
e Explore chapter
e (Creating new reports
— Configuring Reports chapter
— Health Reports chapter
— Deviation Reports chapter
- Ad Hoc Reports chapter
e Viewing, re-running, and scheduling reports
- Reports chapter
- Report Log chapter
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Health Reports

Access: WAE Live > Analytics, click New Report, and select Health Report Type
Access: WAE Live > Explore, select objects, and click Run Report

Health reports enable you to monitor and remedy network health by finding network objects that exhibit
problematic behavior over time. For example, you can report on specific nodes that surpass 90% CPU
utilization.

Each health report uniquely identifies ways in which an object might be considered unhealthy or in the
case of LAGs, which LAGs are imbalanced. For instance, if you ran an interface health report on
utilization over 80%, the resulting report would tell you the percentage of time each interface had over
80% utilization within the given time range, as well as the number of times the operating status changed.
Another example is determining the number of times (Count) that a specific event occurs, such as LSP
path changes.

Once the report is generated, you can then graph the properties over the report time range. These graphs
allow you to drill down to the specific times at which the event occurred. These graphs could indicate
when a specific threshold was violated or they could narrow the threshold violations to a single event.

To configure reports for a specific network, select it from the Network list (top left). If there is only one
network configured, the word “default” appears.

Interface Health

An interface health report gives the percentage of time that incoming and outgoing traffic surpassed a
user-defined threshold. Additionally, it identifies the number of times the operational status changed.

Example: Figure 9-1 shows an example health report output for an interface that was above an 80%
utilization threshold 70.28% of the time, during which time there were 3 operating status changes. The
graph visually shows that one of the peaks in utilization occurred on October 6. Moving the cursor over
that point gives the exact date and utilization values.
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Figure 9-1 Example Interface Health Report

Node Name Coapacity %Time Util In or Util Out over Thres... Count of Operation Status Changes
ilter tex filter tex filter text  filter text ilter text

EU_AMS_AMSIX 2 TenGIigEO/o/1 10000

Mbps

B Traffin Raw — TraffOut Raw

381630

Required Tabs

e See the Configuring Reports chapter.

e Util Threshold—Threshold interface traffic must surpass to be included in the report.

LAG Imbalance

A link aggregation group (LAG) is a group of physical interfaces that are bundled into a single logical
interface. When traffic is not spread evenly across the members, congestion and dropped packets can
occur even though the LAG itself is not congested.

A LAG Imbalance report enables you to determine which LAGs are imbalanced and at risk of dropping
packets or incurring congestion. The basis for determining whether a LAG is included in the report is
whether any of its members surpass a user-specified Util Out threshold. This helps you target potentially
problematic LAGs, avoiding those that do not have sufficient traffic to give accurate results.

The LAG Imbalance report is based on two key parameters.

¢ Include LAGs with members exceeding __% —This value determines which LAGs are included in
the report. If a LAG has any member that passes this Util Out threshold (at any time during the report
period), then the LAG and all of its members are included in the report.

¢ High- and Medium-risk threshold—These values set the thresholds that WAE Live uses to determine
whether a LAG is imbalanced or at risk. The value must be between 0 and 1.

LAG Imbalance and Risk

The LAG Imbalance/Risk graph shows the imbalance and risk compared to the high- and medium-risk
thresholds, as well as whether and when the LAG passes these thresholds. The difference between risk
and imbalance measurements is that risk calculations consider only positive differences, whereas
imbalance calculations consider both negative and positive differences. For instance, Figure 9-2 shows
that a LAG’s utilization was significantly imbalanced for several days, while it was only minimally at
risk.

e Risk = Highest Util Out of Any Member - Average Util Out of All LAG Members
e Imbalance = Higher of these two values.

- Risk

— Average Util Out of All LAG Members - Lowest Util Out of Any Member
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LAG Imbalance W

Example: This example LAG has four members.
e Util Out values are 0.10, 0.35, 0.55, and 0.40.
e Highest Util Out of Any Member = 0.55
e Lowest Util Out of Any Member = 0.10
e Average Util Out of All LAG Members = (0.10 + 0.35 + 0.55 + 0.40)/4 = 0.35
¢ Risk=0.55-0.35=0.20
e Imbalance = 0.25 because it is the higher of the following two values.
— Risk, which is 0.20
- 035-0.10=0.25

Figure 9-2 Example LAG Imbalance and LAG Risk Graph
nclude LAGs with member interfaces exceading 50 % of UtlOut
Thresholds for LAG to be considered imbalanced
High-risk threshold:  0.15 -1
Medium-risk threshold:  0.05

A e e e - - T vey -

Feb. 2 Feb Feb. 4 Feb. 5

X

381637

— Imbalance — High-risk Threshold — Medium-risk Thrashold — Risk

Key

High-Risk Threshold
Medium-Risk Threshold
e IMbaalance

Risk

LAG Member Utilization

The Util Out graph shows the Util Out percentage of all of the LAG’s members over the report period
(Figure 9-3). If you see that a LAG is imbalanced or at risk, this graph is helpful in determining which
of the members is causing these effects.
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Figure 9-3 Example LAG Member Util Out Graph
Include LAGs with member interfaces exceeding 50 % of UtilOut
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Additional Utilization, Imbalance, and Risk Data

In addition to these graphs, the report output includes the following utilization, imbalance, and risk
values.

Example

Number of LAG members, which are viewable individually by clicking on the blue number in the
LAG Members column.

Peak member utilization

Peak aggregated risk

Peak aggregated imbalance

Most recent aggregated risk

Most recent aggregated imbalance

Percentage of time the LAG was over the high-risk threshold

Percentage of time the LAG was over the medium-risk threshold

This example compares two scenarios to demonstrate how you could interpret the data.

LAG A: Nine LAG members are at 60% utilization and one LAG member is at 0%.

While LAG A is imbalanced, it does not appear to be at high risk. Traffic coming into this LAG will
likely not pose a problem since the data suggests that even if one member fails, the other nine
members can handle the traffic.

LAG B: Nine LAG members are at 60% utilization and one LAG member is at 90%.

LAG B is imbalanced and likely at high risk. One particular member is receiving much more traffic
than the other members. If this happens when traffic is coming into LAG B and if that traffic is
assigned to the member with 90% utilization, there might not be sufficient bandwidth left to handle
the traffic, resulting in dropped packets.
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Required Tabs

¢ See the Configuring Reports chapter.
¢ LAG Imbalance

— Include LAGs with members exceeding __% —Specify the percentage of Util Out threshold
used in determining which LAGs are included in the report. If any LAG member surpasses it,
then the LAG is included in the report.

— High- and Medium-risk threshold—Specify the thresholds used to determine whether a LAG is
imbalanced or at risk. The value must be between 0 and 1.

LSP Health

An LSP health report identifies the percentage of time that the LSP traffic surpasses the user-specified
threshold of setup bandwidth (set in the Setup BW Threshold tab). Additionally, it gives the following
information.

e Last setup bandwidth
e Number of actual path changes

e Percentage of time the LSP was not on the shortest TE path

Required Tabs

¢ See the Configuring Reports chapter.

e Setup BW Threshold—Setup bandwidth threshold that LSPs must surpass to be included in the
report.

Node Health

A node health report identifies the percentage of time that the CPU and memory surpass a threshold that
you set in the CPU Threshold and Memory Threshold tabs, respectively.

Required Tabs

e See the Configuring Reports chapter.
¢ CPU Threshold—CPU threshold that nodes must surpass to be included in the report.

e Memory Threshold—Memory threshold that nodes must surpass to be included in the report.

Related Topics

e Objects, Properties, and Data chapter
e Graphs chapter
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e Tables and Filters chapter

e Explore chapter

e Creating new reports

Configuring Reports chapter
Traffic Reports chapter
Deviation Reports chapter

Ad Hoc Reports chapter

e Viewing, re-running, and scheduling reports

Reports chapter
Report Log chapter
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Deviation Reports

Access: WAE Live > Analytics, click New Report, and select Deviation Report Type
Access: WAE Live > Explore, select objects, and click Run Report

The deviation report detects sudden changes in property values. While the report can be applied to any
high-frequency property value, such as nodes’ CPUs, the primary use is to detect rapid increases and
decreases in LSP or interface traffic. Determining the timestamp can assist you in correlating other
network or service events that may have caused a reported surge.

This detection of a deviation is based on how traffic has behaved in the past, which is considered to be
the norm or the moving average. For instance, if traffic normally goes up and down within a specific
band of Mbps, then this is normal traffic and would not be flagged as a deviation.

The moving average and range of acceptable tolerance for the property value are determined by two
configurable fields, each of which creates corresponding lines in the graph.

¢ Size of Historical Window—Identifies how many past data points to use in the calculation of the
moving average.

— The moving average, which appears in the graph, is how WAE Live expects the property value
to change based on past behavior. This is calculated using Bollinger Bands.

— A data point is a point in time in which you collect data. So, for example, if you collect every 5
minutes and you want the moving average to be based on the last 24 hours, you would enter 288.

e Sensitivity—Identifies the tolerance range (standard deviation), which is how far from the moving
average the raw data can be before it is flagged as a deviance: the higher the number, the higher the
tolerance. This creates two lines that are equal distance on either side of the moving average line. If
raw data crosses either the upper or lower band of tolerance, a deviance is recorded. See Figure 10-1
for an example.

You can also set a threshold under which property values are not considered for the deviation calculation,
thus filtering out non-significant deviation points. If the current data point is larger than the upper band
or lower than the lower band, it is compared to the previous data point. If the absolute difference of these
two values is lower than the “Ignore Deviations Under” value, the property value is ignored.

Example: Upper band is 1,000 Mbps and lower band is 500 Mbps. The “Ignore Deviations Under” value
is 5. The last data point is 999 and the current data point is 1003.

1003 (last data point) - 999 (current data point) = 4
4 <5 (Ignore Deviations Under)

Therefore, the current data point of 1003 would not be considered as a deviant. Note that had there not
been an “Ignore Deviations Under” value set, the 1003 data point would be a deviant since it is larger
than the upper band.
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In addition to the graph, the report output identifies the following.
e Number of Deviations

e Average Deviation Amplitude Absolute, which is the size difference between the highest and lowest
property values

e Average Deviation Amplitude Relative, which is a comparison of the absolute amplitude to the
standard deviation

To configure reports for a specific network, select it from the Network list (top left). If there is only one
network configured, the word “default” appears.

Example: Figure 10-2 shows an example of a report identifying two deviations. Figure 10-1 shows the
configuration and an enlarged section of its output.
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Tips for Viewing Graphed Deviations

Figure 10-1 Deviation Report Configuration and Output
Property: Traffic Out "!
Size of Historical Window 16 number of datap. -+
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- Sensitivity: 1 - 5 35
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Traffic Out
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v 1 / Average
. al .
Tolerance Deviation 1
Range — <—Raw Data
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Figure 10-2 Example Deviation Report
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Tips for Viewing Graphed Deviations

Increasing the “Ignore Deviations Under” value can make it easier to see the deviations.

[ ]

e If the number of deviations reported in the table are different than what you see in the graph, use the
zoom feature to see them. Zoom to a chosen timestamp, and note that timestamp. If you do not see
the deviation of interest, zoom to a section of the graph immediately following that timestamp.
Repeat this procedure, if needed, to see all of the deviations.

L[]

If the tooltip for the deviation mark shows that the raw data is within the upper and lower boundaries

(tolerance range), zoom into that deviation mark as many times as needed to see the raw data cross

the boundary.
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Deviation Report Tabs

Required Tabs

¢ See the Configuring Reports chapter.
e Parameters

— Size of Historical Window—Enter the number of past data points (collections) to use in the
calculation of the moving average.

— Sensitivity—Slide the scale to a number from 1 to 5 (including up to one decimal) to specify
the tolerance range, which is how far from the moving average the raw data can be before it is
flagged as a deviance.

— Ignore Deviations Under—(Optional) Enter a number (up to one decimal) to set the threshold
under which property values are not considered for the deviation calculation.

Related Topics

e Objects, Properties, and Data chapter
e Graphs chapter
e Tables and Filters chapter
e Explore chapter
¢ Creating new reports
— Configuring Reports chapter
— Traffic Reports chapter
— Health Reports chapter
- Ad Hoc Reports chapter
e Viewing, re-running, and scheduling reports
- Reports chapter
- Report Log chapter
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Ad Hoc Reports

Access: WAE Live > Analytics, click New Report, and select Ad Hoc Report Type
Access: WAE Live > Explore, select objects, and click Run Report

Ad hoc reports offer a flexible means of customizing reports to meet specific requirements, making them
useful for a variety of use cases. For example, you can average the sum of traffic exiting grouped nodes,
or determine how many times an LSP left its shortest TE path.

The basic ad hoc report creates a table of data in which each table value is the result of the time
aggregation operation applied to the property over the entire report time range. Each row is an object.
Each column is defined by a combination of properties and time aggregations (both of which are selected
in the Data Columns fields).

Time aggregation operations vary, depending on the selected object as follows.

¢ Change Count—Number of times the value changed. For example, if you select Shortest TE Path
for LSPs, you can report on the number of times it changed during the last year.

¢ Count—Number of times the data was collected during the specified time period. For example, if
you collected traffic information once an hour for 24 hours, and the Count was 20, you would know
there was a problem during 4 hours.

e P95, Maximum, Minimum, Average—Time aggregation computations based on these values.
e Last—Last value in the specified time interval
e Percentage Growth—Computation of the percentage of growth.

To configure reports for a specific network, select it from the Network list (top left). If there is only one
network configured, the word “default” appears.

Example: Figure 11-1 shows the output for aggregating P95 Traffic In for interfaces connected to the
EU_LON_BBI1 node. Interface Bundle-Ether2 (row 1) has 14,249.25 Mb of P95 traffic for the last three
months.
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Figure 11-1 Example Ad Hoc Report

Data Columns

Property Time Aggregation

Traffic In E‘ PS5 E‘

Time
Property Aggregation

v v
Node Name Traffic In {P95) il
filter text filter text filter text ®
EU_LON_BB1 Bundle-Ether2 14249.25 ) <] _Graph
Raw Data
EU_LON_BB1 Bundle-Ether1 10891.48 m
EU_LON_BB1 POS0/1/1 5617.18 i g
A 8
Aggregated for
Time Range

Time Intervals

Each combination of property and time aggregation value can be aggregated by time intervals ranging
from hours to years. This broadens the possibilities for how you view the data. For example, you can

report on the average number of dropped packets for the last six months (Time Range), and aggregate
those averages on a weekly basis (Time Interval). Sorting the Dropped Packets Out column would then

show the most problematic interfaces. Another example would be to create yearly reports on a quarterly
basis.

These intervals are viewable as graphs. You can graph the time-aggregation value by clicking the

aggregation value, or you can graph both the raw data and the time-aggregation interval by clicking the
graph icon.

Example: Figure 11-2 extends the report created in Figure 11-1. Here, each property and time
aggregation is further aggregated into a one-week time interval. The difference is that the graph now
shows the P95 aggregation applied to one-week increments across three months. By looking at these
increments you can see that while the raw data fluctuations, the traffic is very steady on a per-week basis.
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Figure 11-2 Example Ad Hoc Report with Graphed Time Aggregations Intervals
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Percentage Growth

Ad hoc reports enable you to determine and graph the percentage of growth for any high-frequency
property over a specified time range. The resulting data is based on time aggregations of the raw traffic
data (for example, average traffic per day). The report tables provide additional information, such as the
number of aggregated objects on which the trending is computed. They also list the percentage at which
the traffic is growing or shrinking.

One potential use for the percentage growth time aggregation would be to identify how fast your traffic
is growing so you can plan for increasing capacity in the future, or whether it is declining, which could
be an indication of a diminishing market or service.

Example: Figure 11-3 shows the output of an ad hoc report that was grouped by node and then by
capacity. The time range was 6 months, and the growth computation was based on the daily maximum
traffic. Sorting on Traffic In (Percent Growth) shows that the EU_LON_BB3 node with 10,000 Mbps
capacity had the largest percentage growth in the last 6 months at 223.08 percent.
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Figure 11-3 Example Ad Hoc Report of Percent Growth

Node Capacity Count Traffic In (Percent Growth) ¥

filter text filter text filter text filter text

EU_LON_BB3 10000 3 223.08

EU_LON_BB3 30000 1 198.27 -
=

EU_LON_BB3 40000 2 11.99 2

Ad Hoc Report Tabs

Required Tabs

For Filter and Time Range, see the Configuring Reports chapter.

Data Columns—Apply the time aggregated operation to the associated property. The selected
property and time aggregation combination defines the output columns for the report. Defining each
Data Column is a two-step process.

— Add or delete properties, as needed.
— To add a property, click the Plus icon.
— To delete a property, click the Trash Can icon.

— For each selected property, identify how you want the data time aggregated for the report time
range. See the Time Aggregation Options section. If you specify Percent Growth, you must
further identify how you want this growth calculated. See the Percent Growth Options section.

Time Aggregation Options

Time aggregation operations vary, depending on the selected object as follows.

Percent Growth Options

Change Count—Number of times the value changed.

Count—Number of times the data was collected during the specified time period.

P95, Maximum, Minimum, Average—Time aggregation computations based on these values.
Last—Last value in the specified time interval.

Percentage Growth—Computation of the percentage of growth.

WAE Live first calculates the trend at which the property value is moving (its direction and frequency),
and then uses this trend to determine the percentage of growth. Set the following parameters to determine
how this percentage is calculated.

Interval— The aggregation basis for the percentage: P95, Maximum, Average, or Minimum.

Per—The aggregation interval that is applied to the raw data before calculating the percentage of
growth. This interval must be less than the report time range.
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Optional Tabs

Example: Ad Hoc Data Aggregation ||

e Trending Algorithm—Algorithm used to compute the percentage of growth. Both the calculation
and the graph differ, depending on which option you choose. Following is a list of how these graphs
are commonly used.

- Exponential —Commonly used when data values increase or decrease at a constantly increasing
rate.

- Linear—Commonly used with linear data that often shows a steady rate of increase or decrease.

— Logarithmic—Commonly used when data changes by increasing or decreasing quickly and then
stabilizing and leveling.

— Power—Commonly used with data measurements that increase at a specific rate.

e Group By—Aggregate the report results by groups. The Overall option aggregates the results for all
objects. For information, see the Configuring Reports chapter.

In the output, you can expand the group to see its objects by clicking the number in the Count
column.

e Time Interval—Apply the time aggregation operations defined in the Data Columns by time
intervals. For more information, see the Time Intervals section.

Example: If you select Traffic as an LSP property in the Data Columns section and P95 as the Time
Aggregation operation, and if you select 1 week as the Time Interval, the resulting graph shows P95
traffic aggregated on a weekly basis (one data point per week, which is the P95 value of Traffic over
that week).

Example: Ad Hoc Data Aggregation

If one plan file is generated per hour, then each day is comprised of 24 raw data points. If you run an ad
hoc report for maximum LSP traffic for the last 12 weeks, and if you use weekly intervals, the resulting
report first aggregates the maximum LSP traffic for those 12 weeks per object (provided those objects
are not grouped). The number of raw data points included in this aggregation would be 169,344 (84 days
* 24 raw data points per day). These aggregated values appear in the table columns. Additionally, the
intervals would be aggregated per week for a total of 168 raw data points per each of the 12 weeks (168
=7 days * 24 raw data points per day). These intervals are viewable as graphs. For information on how
raw data is collected, see the Objects, Properties, and Data chapter.

Example Ad Hoc Report

Figure 11-4 shows an example ad hoc report generated to determine the aggregated weekly maximum
outgoing traffic per node over the past year. It also includes a calculation for the percentage of growth
The totals in the resulting report are for three months, and the graphs show the traffic aggregated in
weekly increments. Clicking the number in the Count column shows the names of the interfaces.

The table is filtered by EU nodes and sorted on the Traffic Out (Maximum) column to show which
European nodes have the highest outbound traffic using the given aggregation. For the European nodes
with the highest traffic, the table also shows that these nodes have little fluctuation in their growth, but
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that all but one has decreasing traffic. The node showing the greatest percentage of loss is
EU_MAD_BB2 at -23.25 percent loss over the last three months. Yet, you can also determine that while
it is showing a percentage growth loss over time, the node has traffic spikes.

Report Configuration Parameters

Report Type Ad Hoc

Object Interfaces

Filter Node

Time Range Last three months

Group By Node

Time Interval 1 week

Data columns Traffic Out, Maximum
Traffic Out, Percentage Growth based on a maximum interval of 1 day
using a linear trend

Figure 11-4 Example Ad Hoc Report

Node Count Traffic Out (Maximum) ™ Traffic Out {Percent Growth)
EU filter text filter text filter text

EU_LON_BB1 226203,00 212

EU_PAR_BE1 26 20912462 2.95

EU_PAR_BB3 16 129778.63

EU_AMS_BB2 19 85742.99 1.28

EU_LON_BB2 13 8525413

EU_AMS_BE1 12 7.01
EU_MAD_BB1 7
EU_MAD_BB2 8 41286.45 23.25
Interfaces: EU_MAD_BB2
TraffOut
|
2 I
') [
o
&
TralfOut Raw Traffic Out Maximism Tralfic Out Percent Growth ]
o

Related Topics

e Objects, Properties, and Data chapter
e Graphs chapter

e Tables and Filters chapter

e Explore chapter

e Creating new reports
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Ad Hoc Reports

Configuring Reports chapter
Traffic Reports chapter
Health Reports chapter

Deviation Reports chapter

e Viewing, re-running, and scheduling reports

Reports chapter
Report Log chapter

Related Topics W
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Reports

Access: WAE Live > Analytics
Access: WAE Live > Analytics > Report Log, click Show Reports

The Reports page is the page from which most report management occurs. It lists all reports for all
networks that have been assigned names. You cannot view report logs a per-network basis.

From this page you can view when the report was last ran, rerun the report, change its name, schedule it
to run at specific intervals or dates, and have the report automatically emailed.

To view reports for a specific network, select it from the Network list (top left). If there is only one
network configured, the word “default” appears.

Schedule Reports

Step 1

Step 2

Step 3

Step 4
Step 5

Step 6

You can schedule reports to run once or at regular intervals, and have these results emailed to you and
to others. You can also send alerts when the state of your network matches conditions that you define

using filters. For example, if want to be notified if interfaces exceed 90% utilization, you can apply and
save report filters to meet this criteria, and then schedule an email alert to be sent if this condition is met.

If you want to email report results based on specific criteria, set the filters before opening this dialog
box. Similarly, if you want emailed reports returned with a specific column sorted, save the report with
this column sorted. For information, see the Configuring Reports chapter.

From the Reports page, either select View > Scheduling or click the Scheduled link associated with the
report you want to schedule. The Schedule dialog box appears.

To turn on scheduling, select the options that fit your needs. You can schedule the time of day for the
report to run, and you can run reports once on a specific day, daily, weekly, monthly, or on a specified
number of weeks or months.

To turn off scheduling, select None.
To email scheduled reports, enter one or more email addresses separated by commas.

If emailing reports, either specify that they always be sent or only if they contain data (they are
non-empty). If you are emailing the report based only on specified criteria (step #1), select “non-empty
report.”

Click Save.
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Reports Table

Report Name—Name of the report. Click the name to open the Configure Report page with the
parameters selected that were used to create the report.

Time Range—Duration of the report.

Last Run—Date and time of the last time the report was run. If the report has been run multiple
times, click the icon next to the date to list the available reports. To run one of these reports, select
it and then click Select.

Scheduled—Frequency of how often the report is automatically run. Click the link to schedule the
report to run, to email the report, or to stop running the report if already scheduled. See the Schedule
Reports section.

Owner—Username of the person who created the report. If LDAP is the authentication method, this
is the same as the LDAP client username. By filtering on your username, you can view only the
reports that you created.

View options
— View—<Click to view the report output.
— View Run—Run the report with same parameters.

- View > Edit—Open the Configure Report page with the parameters selected that were used to
create the report. If you run and rename the report, it replaces the name of the existing report.

- View > Scheduling—Open the page that enables you to schedule the report to run, to email the
report, or to stop running the report if already scheduled. See the Schedule Reports section.

— View > Delete—Remove the report from this Reports page. The report remains listed on the
Report Log page.

Related Topics

Tables and Filters chapter
Creating new reports

— Configuring Reports chapter

— Traffic Reports chapter

— Health Reports chapter

— Deviation Reports chapter

— Ad Hoc Reports chapter
Report Log chapter
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Access: WAE Live > Analytics, click Show Report Log

The Analytics Report Log page lists all previously run reports and information that further defines them,
such as their start and end time. From this page you can view report results, rerun the report, or edit the
report configuration before rerunning.

The reports appear by default names unless you renamed them. To view reports for a specific network,
select it from the Network list (top left). If there is only one network configured, the word “default”

appears.

Like other Explore pages, you can filter and sort the Report Log table, as described in the Tables and

Filters chapter.

Report Log Table

e Report Name—Name of the report. Click it to open the Configure Report page with the parameters

selected that were used to create the report.

e Job ID—Specific instance of a report. A unique Job ID is generated each time a report is run. The
Job ID is required information for importing traffic reports into the WAE Design GUI.

e Definition ID—Uniquely identifies the report. If the same report is run multiple times with the same

parameters, its Definition ID stays the same.

filter text
T Over_80 12
15

16

filter text

filter text

12

13

13

Same Report
Different Job ID

e View options

— View—<Click to view the report output.

Same Report
Same Definition ID

381612

— View > Edit—Open the Configure Report page with the parameters selected that were used to

create the report.
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M Related Topics

— View > Download CSV—Export the table in a tab-delimited format.

Related Topics

e Tables and Filters chapter

¢ Creating new reports

Configuring Reports chapter
Traffic Reports chapter
Health Reports chapter
Deviation Reports chapter

Ad Hoc Reports chapter

e Reports chapter
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CHAPTER

Map

Access: WAE Live > Map

The Map page provides a high-level view of the current network health through a near-realtime
weathermap and health panels of critical peering traffic and network issues. Since the information is
current and highly visual, you can see at a glance whether and where there are problems in the network,
such as congestion. Because the Map and Explore capabilities are tightly coupled, you can immediately
drill down to detailed information to troubleshoot network issues.

ag1618

=

WAE Live weathermaps are generated by the network topology and traffic information that WAE
Collector discovers. This information is stored in a series of plan files called snapshots that are navigable
by date.

Two panels, Peering and Events, offer immediate information on network health. The Peering panel
enables you to monitor top peers and verify traffic is balanced across peers and sites. The Events panel
lists the predominate types of network concerns, such as interfaces down, enabling you to determine how
many there are total and how many have changed since the last snapshot was taken.

To view a weathermap for a specific network, select it from the Network list (top left). If there is only
one network configured, the word “default” appears.

The visualization of the weathermap is based on how your administrator laid out the template. For
detailed descriptions of the objects, backgrounds, and traffic utilization colors, see the WAE Network
Visualization Guide.
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Read Network Health

Read Network Health

Traffic Utilization

] Cisco WAE Live 6.3 User Guide

WAE Live offers multiple ways to quickly assess network health. The most immediate way is to look at
the color of the interfaces, nodes, and sites in the weathermap and to look at the color of the peer icons
in the Peering health panel. These colors represent the outbound traffic utilization on the interface. If

parallel circuits' have been grouped, these utilizations represent the average of the grouped interfaces.

Example Interface Traffic Utilization

30 -50 %

Design Weathermap
Layout Layout

] 80-90 %

383343

Default utilization colors depends on how your administrator set up the visualization of the plan file.
This visualization might be either in a Design or Weathermap color scheme. Default colors are blue,
green, yellow, orange, red, and purple (Design) or magenta (Weathermap), and sequentially each of these
colors represents increased utilization.

Note these colors are configurable in the WAE Design GUI where the administrator creates the template
for the WAE Live plan files. The utilization legend at the bottom of the weathermap identifies the
template’s utilization colors and their values.

1EacleircuitonnectgpainfnterfaceonlifferennodesCircuitargarallelfheshavehsamsource
node and same destination node as each other.
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Utilization Legend

% Utilization [x] ——— Show/Hide

=0
<=30
<=8
=<=80
{=m
=<=100

381624

Peering Health Panel

The Peering health panel (Figure 14-1) is based on BGP information. It shows the highest traffic
utilization per peer and per site. This panel enables you to monitor critical peers and their growth so that
you can quickly detect and overcome congestion issues.

Figure 14-1 Peering Health Panel
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| | AP _TOK_BBZet-0/1/2.0

N
N

Peer1 - ASN 1001
External
Peer2 - ASN 1002

|
Peers E
N

Mbps

Peer4 - ASN 1004

/
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|
|
l\
1
Z‘v
4
||
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The far left column lists the peers, while each top column lists the associated sites. The icons represent
the traffic flowing between the two. While the color gives you a visual indication of traffic, hovering the
mouse over each icon lists the numeric values.

Highest Utilization of
Traffic for this Peer
99/89
|#‘ Going to this Site
Highest Utilization
Of Incoming Traffic for this
Peer Coming from this Site

asaz

To navigate to graphs for all interfaces connected to that peer, click the icon. Graphs appear for only
those interfaces connecting this peer on its associated site. To go to the associated Explore page for these
interfaces, click the All Interfaces link at the top of the graphs.

Note  The administrator can configure this panel name to something other than “Peering.” For information, see
the WAE Live Administration Guide.
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Events Health Panel

The Events health panel lists the number of current events and the number of changes since the last plan
file was received.

e Event—The event being tracked. The default set is as follows, though these can be configured
differently.

— Circuits down
- Nodes down
— Interfaces errors/drops
— External (peering) interfaces over 80%
- Internal (non-peering) interfaces over 80%
¢ Count—The number of objects of that event type.
Example: If there are 10 nodes total that are down, the Nodes Down Count is 10.
e Last Delta—How many objects have changed their state since the last snapshot was taken.

Example: If 4 nodes came up since the last snapshot, and 3 nodes went down, the Last Delta column
would show +4/-3. Note, if the Count was previously 10, it would now be 11.

Events Count Last A

JE1616

Nodes Down 11 +4/-3

~
Note  The administrator can configure this panel name to something other than “Events” and can configure a
different set of events to appear in this panel. For information, see the WAE Live Administration Guide.

Navigate to Related Explore Information

From a weathermap, you can navigate to related Explore information for nodes and interfaces. Note that
regardless of the plan file date, the resulting Explore information is the most recent. For more
information on Explore capabilities, see the Explore chapter.

Node CPU and Memory

To graph node CPU and memory usage, click its parent site. From here you can graph usage for this
particular node, or you can go to the Explore tables for one or more nodes in the site.

Cisco WAE Live 6.3 User Guide
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Go to Explore

Change Graph
Single Node

Time Frame

Week -

2011-08
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15 10:49 (UTC) ch
A

CPUO: 9¢

Memory

381619

Read Network Health 1l

Graph Node CPU and Memory Usage

View Node Tables

Click a node in the site view.

e The top pane graphs both CPUO (blue) and CPU1

(red).

e The lower pane graphs both Memory0 (blue) and

Memoryl (red).

e To view the numeric values, move the cursor over

the graph, and a tooltip lists the values.

e To view an Explore table for a single
node, open its graph and click its name
link.

e To view an Explore table containing
data for all nodes in a site, click the All
Nodes link in the site view.

Interface Traffic In/Traffic Out

To graph the traffic coming into an interface and leaving it, click the interface. The height of the interface
is in relationship to the capacity so you can see how close the interface is to being filled. If the
weathermap is displaying an interface group, all interfaces within it appear in the graph.

From here you can go to the Explore tables for one or more interfaces in the group by clicking on name

of the interface.

Graph Interface Traffic In/Traffic Out

View Interface Tables

Click an interface or set of grouped interfaces.
(Interfaces with a common source and destination
are sometimes grouped in the template to improve
visualization.) A single interface and grouped
interfaces look the same in the weathermap.

e Ifyouclick an interface group, multiple graphs
appear.

e The Traffic In (ingress) is green, and the
Traffic Out (Egress) is blue.

e To view the numeric values, move the cursor
over the graph, and a tooltip lists the values.

e To view an Explore table for a single
interface, open its graph and click its name
link.

e To view an Explore table for all interfaces in
a group, open its graph and click the All
Interfaces link.

e To view an Explore table for all interfaces in
a site, click the site to open it. Then click the
All Interfaces link in the site view.
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Weathermap

By default, the weathermap shows the current topology. The control panel (Figure 14-2) at the top
enables you to navigate to different snapshots (plan files from different times and dates), view different
QoS service classes and layouts, view specific plots, and change the manner in which circuits are
displayed (Plot Options). From the weathermap and from its sites, you can navigate to more specific
information about interfaces and nodes as described in the Navigate to Related Explore Information
section.

Map Objects

The objects appearing in on the Map page represent the network topology. How they appear can differ
depending on how the layout was set up to visualize the network.

Site

& ®
4 L 81
\_Clﬂ'g 2 //
< g 4
Site View $ B

q

¢ A node (router) appears as either a disk or a rectangle. Nodes can reside both inside and outside of
sites.

e Assite is a WAE construct to make visualization of networks easier to read. Sites appear as either a
square (which is a peer or non-peer site), a circle (non-peer site), or cloud (peer site).
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Weathermap W

Unless a site is empty, there is a hierarchy of the sites and nodes that a site contains. A site can be
both a parent and a child site. A site that contains another site is called a parent site. The contained
nodes and sites are called children. Often the child nodes and sites are geographically co-located.
For instance, a site might be a PoP where the routers reside.

— In the weathermap, the parent site shows all egress inter-site interfaces of all nodes contained
within it, no matter how deeply the nodes are nested. Similarly, this is true for each child site
view within it.

— Inasite view, the “All Nodes” and “All Interfaces” links show a count for (and filter to) all nodes
and interfaces directly within that site. That is, it does not show nodes and interfaces for nested
sites.

— To open a site view, follow one of these two steps.
— Select a site from the Site drop-down list in the control panel.
— Double-click a site in the weathermap.

Interface—Each pair of interfaces connects two different nodes. Their colors represent the outbound
traffic utilization. For more information, see Traffic Utilization section.

Control Panel Options

Plan File Navigation—Click to save the file to a location of your choice. See the Navigate to Specific
Weathermap section.

QoS—Displays the type of traffic to view in the weathermap as differentiated by the QoS model.
Note that if you navigate to an Explore page while displaying QoS traffic, the Explore page shows
only undifferentiated traffic.

— Undifferentiated traffic—Aggregate traffic on an interface.
— Service class—Administratively defined classification of traffic that is not discovered.

- Queue—Interface traffic belonging to the selected queue. Queues and their traffic are
discoverable by WAE Collector.

— They can be manually created and configured during the snapshot process to be associated
with a set of user-defined QoS parameters that specify how these queues are prioritized and
what percentage of traffic they carry.

— Queue names are preceded by a “Q:” in the list.

Site—Displays a list of sites available for viewing, as well as the entire weathermap. If you click on
a site, the weathermap shows the nodes and intrasite circuits within the site.

Layout—The manner in which plan files are laid out to visualize the network is called a layout. This
option displays a list of available weathermap layouts. Example layouts might include schematic
layouts, geographic layouts, or separate layouts for different continents.

The default layout is configurable by the administrator. Upon first opening WAE Live, this is the
layout that you see. However, the last layout viewed before closing the browser is the one that
appears the next time you open WAE Live provided you are using the same browser.

Plot Options—Enables you to modify visual circuit attributes of the weathermap. See the Set Plot
Options section.

Full Screen—Enables you to view an enlarged weathermap without the control panel and without
the health panels.
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Figure 14-2 Weathermap Control Panel
View Weathermap Change Sh_“"“' Only Weathermap
By Service Class Layout (Hide Control Panel and
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Plan File Navigation Full Weathermap Plot View for 2
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Navigate to Specific Weathermap

By default, the weathermap shows the most recent snapshot (plan file) taken. You can, however, navigate
to plan files created at different times and on different days.

Move Backwards or Select Plan

Forward by Time Increments

<< < 201371011 01:45 H > > >
2013/10/11 01:45
201310711 01:30
2013/10/11 01:15

Select Plan File

as1623

Plan File Navigation Options

¢ Single forward and back arrows—Move forwards or backwards by one increment in time.

¢ Double left arrow—View a plan file from yesterday.

e Double right arrow—View a plan file for the next day (assuming you are not on the current day).
e Double arrow with a bar—View the most recent plan file.

e Drop-down list—Select a different plan file based on its date and time from the date drop-down list.

e (Calendar icon—Show a calendar wherein you can navigate to the desired month, and select the
desired date.

Set Plot Options

To modify the visual attributes of the circuits, click the Plot Options link. Options are retained for future
sessions. To restore values to the system defaults, click the Reset to Defaults button.

The circuit width is based on its capacity (the higher the capacity, the wider the circuit). Using these
options, you can set the minimum width and the capacity it represents, as well as how fast the width
grows as the capacity grows.
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Related Topics W

Related Topics

e Objects, Properties, and Data chapter
e Explore chapter

e WAE Network Visualization Guide

e WAE Live Administration Guide
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